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Introduction 3

1 Introduction
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This manual introduces you to ClickBook and guides you through the installation process and setting
up your printer. It gives step-by-step instructions for printing and assembling example booklets, as well
as generalized steps for printing any document.

To learn about ClickBook, please explore the many ClickBook options. Refer to the on-line Help
system for a thorough explanation of all that ClickBook has to offer and how to utilize its many features.

Note: ClickBook for Macintosh works with any version of OS 10. If you have version 10.2.4 or higher, you can enable PDF
Work flow to make using ClickBook for Macintosh easier. If you have an earlier version of the Macintosh operating system, you
will print to PDF and then drag the PDF to ClickBook to create your booklet.

2 Getting Started

Can’'t take it with you?

Book It!

Make your information as mobile as you are. Book it! ClickBook is a powerful
yet easy-to-use printing utility that lets you gather information from different
sources to create customized printed portable publications.

© 2004 Blue Squirrel
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2.1

What Does ClickBook Do?

ClickBook prints files, documents, graphics, spreadsheets, or web pages from any Macintosh
application:

As Double or Single sided.
As Books of any size.

As brochures or leaflets.
As greeting cards.

As CD Jewel Cases.

As Day Planners.

As business cards.

As Zip Cases.

As Avery Labels.

7
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- ClickBook
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Top Uses for ClickBook:

Print double-sided without a duplexing printer.

Print organization charts or schedules on large posters

Fit a large spreadsheet on one page with several pages on each sheet of paper.
Combine documents, Web pages, and other files into a single print job.

Print an address book to fit in your day planner, purse, wallet, etc.

Create a list of songs and artists and print a booklet that will fitin a CD Jewel Case.
Design Greeting Cards or print electronic greeting cards received.

Clip coupons and make a coupon book.

Gather a collection of recipes and print them as a wallet booklet.

Sales & Marketing Managers use ClickBook to print media, product information, press kits, news,
etc.

Educators print handouts, assignments, lessons, ebooks, etc.

About printing books

Printing books requires a special arrangement of the pages. ClickBook takes care of this, giving you
instructions each step of the way so that the back sides are printed correctly relative to the front sides,
and so that after you cut and assemble the book, the pages come out in the right order.

ClickBook has over 69 layouts to choose from, and you can create your own so the variety is endless.
The layouts that come with ClickBook enable you to print books with the following characteristics.

Sizes from full-sheet down to credit card size.
Suited for folding and stapling or for cutting and binding by any method.
Two "binding orientations": for binding in the left margin (and turning pages in the standard way) or

© 2004 Blue Squirrel



Getting Started 5

in the top margin (and flipping pages up).
e Pages of book oriented either as portrait or as landscape.

2.2 How Does ClickBook Work?

ClickBook

- Page Setup... {+3#P =7
" Print... %P (land - r.__--h“a - ;‘i AE

ClickBook takes the output of your application program's print command — exactly what would print if
you were not using ClickBook — and shrinks and rearranges the pages to fit the layout you choose.

ClickBook does not change any formatting done by the application program. Each page is preserved
exactly as the application sent it, including margins, page numbering, headers/footers, and all
paragraph formatting — everything.

ClickBook formats your document in some or all of the following ways, depending on the printout layout
you select and any modifications you may make to it:

¢ Shrinking to fit several pages ("mini-pages") on one sheet of paper, or to fit an oversized page on
the desired paper size.

Arranging the mini-pages so that they come out in numerical order after cutting and assembling.
Printing double sided.

Adding ClickBook margins.

Adding extra space for binding.

2.3 What's New in ClickBook 3.0?

Below is a list of the new features we have added to ClickBook 3.0.

e OS X Support.
e New Layouts - over 30 new layouts to choose from.
Layout Descriptions - displays a short explanation for the selected Layout at the bottom of the

Layouts.
Import/Export Layouts from other platforms.

Choose Metric or U.S. units.

New and improved interface.

Printer Setup Wizard - simple process to setup printers to work with ClickBook.
Avery Labels - addition of Avery's top label formats.

PDF document support - save as PDF or print as PDF.

3 Installation

A summary of what the installation process does:

o Drag and drop installation.

e When ClickBook is run it installs a control panel (called ClickBook Setup) in your Control Panel
folder. (For printing in classic applications.)

System Requirements

© 2004 Blue Squirrel
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3.1

A minimum of 64MB of RAM
System OS X or higher

At least 5.5 MB of free disk space
A laser, or inkjet printer

An application to print from.

Run the Setup Program

To use ClickBook you need to understand and be able to use standard Macintosh operations like
double-clicking and dragging. If you need help with basic Macintosh operations check the manual that
came with your Macintosh.

nstalhng ClickBook from a CD:

Load the ClickBook CD-ROM into your computer's CD-ROM drive.

Drag and drop the ClickBook program into your Applications folder on your hard drive.

Double-click on the ClickBook icon in your Applications folder to run the program.

When ClickBook is run the first time you will see the Welcome to ClickBook dialog.

Click Next to setup the Classic /OS 9 support. For Classic Applications, ClickBook will install a

Control Panel when it is run the first time. You'll need to restart your computer before ClickBook

can print. To restart your computer use the Restart command on the Classic Control Panel in your

System Preferences. (You do not need to restart the entire computer, just the Classic

environment.)

6. Click Next to setup OS X support. Choose Activate PDF WorkFlow so that you can print from
other Applications directly into ClickBook.

7. Click Next to learn how to setup your printer(s) to work with ClickBook.

8. Click Done.

agrwdE

nstalling ClickBook from the Internet:

Download the ClickBook.dmg file from the Blue Squirrel Web Site.

Double-click on the ClickBook.dmyg file. A virtual drive will mount on your desktop.

Drag and drop the ClickBook into your Applications folder on your hard drive.

Double-click on the ClickBook icon in your Applications folder to run the program.

When ClickBook is run the first time you will see the Welcome to ClickBook dialog.

Click Next to setup the Classic /OS 9 support. For Classic Applications, ClickBook will install a

Control Panel when it is run the first time. You'll need to restart your computer before ClickBook

can print. To restart your computer use the Restart command on the Classic Control Panel in your

System Preferences. (You do not need to restart the entire computer, just the Classic

environment.)

7. Click Next to setup OS X support. Choose Activate PDF WorkFlow so that you can print from
other Applications directly into ClickBook.

8. Click Next to learn how to setup your printer(s) to work with ClickBook.

9. Click Done.

oukrwnpE

Note: If you want to have ClickBook readily available you can drag and drop the ClickBook icon onto
your Dock.

When the Setup program is completed, you will need to setup your printer(s) to work with ClickBook,
and then you're ready to print with ClickBook. See Printer Setup for instructions.

© 2004 Blue Squirrel



Installation 7

3.2 The First Time You Run ClickBook

The first time you run ClickBook the Welcome to ClickBook screen will open requiring you to setup the
software to work with your operating system and printer.

Welcome to ClickBoolk!

) | Welcome | Classic/0S9 0OSX Printer - =

Welcome to ClickBook!

Before getting started, we need to set up a few things so that ClickBook
can capture printouts from your other applications.

This setup only needs to be done once, after which you can create your
own layouts and do many other wonderful and creative things.

Once you begin to use ClickBook for a while, you'll wonder how you ever
could print without it!

N Click BOOK

Blue Sguirrel Corporation

1. Please click Next to proceed.

2. The Classic / OS 9 tab will be displayed. Please follow the directions to restart Classic if you wish
to print applications with ClickBook.

© 2004 Blue Squirrel
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3.
4,

Welcome to ClickBook!

- Welcome | Classic /059 | OS5X Printer L

ClickBook requires a control panel to capture print jobs in Mac OS5 9 or
under the Classic environment. It allows you to specify when ClickBook
should grab the print job and display it in its Jobs list.

The ClickBook Setup control panel is already installed. However, this
version of ClickBook does not work with Classic applications. Please look
for an upgrade in the next few months to provide Classic support.

(Frevicus) (— MNext

)

Please click Next to proceed.
The OS X tab will be displayed. Click the Activate PDF WorkFlow button to setup ClickBook to
capture files from Mac OS X programs.

Welcome to ClickBoolk!

- Welcome Classic /OS99 | OSX | Printer |

PDF Workflow (available in Mac 05 X 10.2.4 and above) enables you to
print directly from your Mac 05 X application to ClickBook. Activating this
option adds a new popup button to your Print dialog box, allowing you to
select ClickBook as the recipient of the POF document. You will see this
change in all your Mac OS X applications.

You can also drag and drop existing PDF documents (or Open them from
the File menu) into the ClickBook Jobs list. These documents can be
printed just like the documents generated through PDF Workflow. This is
the only way to use ClickBook under Mac O5 X in version 10.2.3 or below.

(; Activate PDF Workflow )

Remowve PDF Workﬂ ow

( Frevicusj.l (—Nm—)
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5. Please click Next to proceed.
6. The Printer tab appears giving you directions to setup your printers to work with ClickBook.

Welcome to ClickBook!

- - Welcome Classic /059 OS5 X | Printer } -

The last thing you will need to do is to tell ClickBook about the printers
you will be using.

Each printer that you want to use with ClickBook needs to be specified so
that we will know how to print pages to it correctly. You can specify all
your printers now or do only the ones you want to start using immediately.

After you close this window, click the Setup button to setup your printers.
Then, any time you add a printer to your machine (or to your netwaork)
you can use the Setup window to tell ClickBook about it.

{Frevicus; ( Done )

7. Press Done to close the Welcome dialog and begin using ClickBook.
8. Refer to Easy Printer Setup to setup your printers.

3.3  Printer Setup

After installation, you may need to set up your printer in ClickBook. The paper path of many printers is
automatically recognized by ClickBook. If yours is not, then you need to run theption in ClickBook:

© 2004 Blue Squirrel
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Printer Setup

Printer: ' Phaser 850DP H4
Defined as: Tektronix Phaser 840

- { Easy | Manual Custom Duplex | Help ] -

Here is a list of printer types that ClickBook already knows a lot about. If
your printer is in the list, just choose it. If it isn't, then you may need to use
the Custom Setup assistant.

If your printer isn't in the list but you know your printer's paper path to be
the same as one that is, then choose the one that is like it.

| Printer Name
StyleWriter 3
StyleWriter 11
TSFAX
WINFAX
Xerox WorkCentre XES0fx m
Xerox WorkCentre XK Series v

(" Print Setup | (: Cancel ::I (—Gl(-—)

EASY Printer Setup:

1.

2.

Make sure the printer you wish to set up is ready to print (turned on, on-line, paper loaded, defined
in the OS X Print Setup, etc.)

Launch the ClickBook application (this can be done from your Hard Drive, or by printing to
ClickBook from an application).

Select the Setup button on the ClickBook toolbar.

Read the text displayed on the tab.

Choose the printer you want to setup from the Printer drop-down list. (If you have more than one
printer they will be displayed in the Printer drop-down list.)

Select the Easy Printer Setup button.

Highlight the name of your printer and select the OK button.

If you have a duplexing printer, click on the Print Setup button, choose Layout from the drop down
menu and choose the radio button for Two Sided Printing.

Please repeat steps 3 through 8 to setup a second, third, or fourth printer.

If your printer is not in the list, select the Custom Printer Setup Wizard
or Manual Printer Setup and follow the instructions.

Some printers rotate landscape print jobs backwards. If you use a layout and the back-sides are not
correct (typically, upside down), go to the Manual tab of ClickBook's Printer Setup. In the For
Landscape, Printer rotates paper section choose the opposite radio button: 90 degrees to the left, or 90
degrees to the right.

© 2004 Blue Squirrel
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3.4  Custom Printer Setup Wizard

If you are unable to setup a printer using the Easy Printer Setup, we recommend using the Custom
Printer Setup Wizard to assist you.

Printer Setup

Printer: | Phaser 850DP b4
Defined as: Tektronix Phaser 840

' Easy Manual | Custom | Duplex Help _1-

If your printer does not appear in the Easy setup list, you can use the
Custom Setup assistant to tell ClickBook about your printer.

The Custom Setup assistant will print a pair of pages and ask you to answer
a few guestions about them. It will then have you place these pages back in
your printer and print them a second time. After you answer a few more
questions, ClickBook will be able to determine the way your printer prints.

Each time you handle the printout, it's crucial to this exercise that you
preserve the order and orientation of the pages. So we will ask you to hold
the printout as though the two sheets were alued together, not rearranging
them, nor looking at the inside pages.

MOTE: Feed the paper into the printer in the same way you intend to when

printing from ClickBook. That is, use the same tray(s) you normally would.

For more information, go to the Help manual and select "paper-tray” in the
help index.

S
( Custom Setup )

(" Print Setup lL Cancel ) (——6&'—-)

CUSTOM Printer Setup

1. Make sure the printer you wish to set up is ready to print (turned on, on-line, paper loaded, defined
in the OS X Print Setup, etc.)

2. Launch the ClickBook application (this can be done from your Hard Drive, or by printing to
ClickBook from an application).

3. Select the Setup button on the ClickBook toolbar, the Printer Setup dialog appears.

4. Read the text displayed on the tab.

5. Choose the printer you want to setup from the Printer drop-down list. (If you have more than one
printer they will be displayed in the Printer drop-down list.)

6. Select the Custom Printer Setup tab, and the Custom Setup button. You will be guided through the
custom printer process.

7. Carefully follow the steps and press Done when you have completed the process.

8. If you have a duplexing printer, click on the Print Setup button, choose Layout from the drop down
menu and choose the radio button for Two Sided Printing.

9. Please repeat steps 3 through 8 to setup a second, third or fourth printer.

© 2004 Blue Squirrel
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3.5

Setup Duplex Printing

If you have a Duplex Printer you'll need to setup ClickBook to recognize that your printer can
automatically print double-sided with no human intervention.

Printer Setup

Printer: | Phaser 850DP 3

Defined as: Tektronix Phaser 840

-

| Print Setup -\jl

Easy Manual Custom | Duplex | Help ]

Use the Print Setup button, below, to enable duplexing for your printer.
(Because Mac O5 X has no direct way for applications to turn on duplexing,
ClickBook needs you to 58t it ance manually.)

For O5 X 10.2.x, select the Duplex option from the pop-up menu to enable
duplexing. Turn on the checkbox labeled "Print on Both Sides” and select the
side-by-side icon.

For Mac 05 X 10.3.x, select the Layout option from the pop-up menu.
Change the "Two Sided Printing” option from "0Off" to "Long-Edge Binding".

Click the "Print" button when you are ready to sawve your settings. Once
duplexing has been set, ClickBook will remember it for future print jobs.

You can also experiment with other the settings in the Print dialog, including
the border that is drawn on each page. However, please don't change the
Pages per Sheet setting. Changing that option will cause your booklets to
print incorrecthy.

I Cancelj} ( oK

)

After you have setup a printer using the Easy Printer Setup or Custom Printer Setup Wizard follow

these steps:

1. Launch the ClickBook application (this can be done from your Hard Drive, or by printing to
ClickBook from an application).

2. Select the Setup button on the ClickBook toolbar.
3. Click on the Print Setup button, choose Layout from the drop down menu and choose the radio
button for Two Sided Printing.

4. Press Print to save your changes.

© 2004 Blue Squirrel
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Print

Printer; |

Presets:

Resource_Center

_( Standard

" Layout

Pages per Sheet: |

Layout Direction:

Border:

Two Sided Printing:

None

"

) Off
™ Long-Edge Binding
_) Short Edge Binding

@ & # G

3.6  Printer Setup Help

( Cancel ) M

The Help tab provides assistance with setting up your printer to work with ClickBook.

© 2004 Blue Squirrel
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1.
2.
3.
4.

3.7

3.8

Printer Setup

Printer: ' Phaser 850DP F
Defined as: Tektronix Phaser 840

f

Easy Manual Custom Duplex | Heip}

This dialog allows you to tell ClickBook about the printers you will be using.
Because printers have different ways of feeding paper, your booklets may
print incorrectly if ClickBook doesn't know how your printer works.

There are three ways to define your printer's paper path: Easy, Manual, and
Custom. The Easy panel lets you pick your printer from a list of known
printer types. This is the method you will want to try first.

Use the Manual panel to explicitly specify how your printer works. You can
either adjust the settings directly or go to our website to see if we have an
auto-configuration value for you to use.

The Custom Setup assistant attempts to determine your printer by printing a
test document and having you answer questions about it

Regardless of which method you use, you can use the Print Setup button to
tell ClickBook about the paper trays, duplexing, and color resolutions you
will be printing with.

(" Print Setup ) (" Cancel ) (——6&——-}

To access the Printer Setup Help menu follow these steps:

Launch the ClickBook application (this can be done from your Hard Drive, or by printing to
ClickBook from an application).

Select the Setup button on the ClickBook toolbar, the Printer Setup dialog appears.

Choose the Help tab and read the text displayed for guidelines on setting up a printer to work with
ClickBook.

Press OK when you are finished, or Cancel to close the dialog.

Update ClickBook

Please check the Blue Squirrel Web Site for updates to newer versions of ClickBook.
Visit: http://www.bluesquirrel.com/cd macch/.

Uninstalling ClickBook

To uninstall ClickBook from your computer please follow these steps:

1.
2.

Open your Applications folder and locate the ClickBook icon.
Drag and drop the ClickBook icon to your trash can.

© 2004 Blue Squirrel
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Y

If you want to uninstall PDF WorkFlow select Welesmz from ClickBook's main screen. The Welcome
dialog will appear. Select the OS X tab and choose Remove PDF workflow.

Welcome to ClickBook!

! Welcome Classic /059 | OSX | Printer ]

PDF Workflow (available in Mac 05 X 10.2.4 and above) enables you to
print directly from your Mac 05 X application to ClickBook. Activating this
option adds a new popup button to your Print dialog box, allowing you to
select ClickBook as the recipient of the PDF document. You will see this
change in all your Mac OS X applications.

You can also drag and drop existing POF documents (or Open them from
the File menu) into the ClickBook Jobs list. These documents can be
printed just like the documents generated through PDF Workflow. This is
the only way to use ClickBook under Mac O5 X in version 10.2.3 or below.

i; Activate PDF Workflow )

Re move _P:DI_: 'l.-‘?ﬁ rkﬂ ow

( Frevious) (—Nm—)

4 Tour ClickBook
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4.1 ClickBook's Main Screen

ClickBook's main window is divided into five separate parts: Title bar , Toolbar , Print Jobs, and Print

Preview.
.80 ClickBook
~ - @ [ Click BOOK
Welcome Options Setup Layouts Help Ml Squj e Corpormticn
Print Document Pages - Copies
M  TitlePage.pdf 1 1
E CIS564.4CourseNotes. pdf 30 1
E Appendix. pdf 4 1
36 1
Total Pages: 35 Layout: '_ ISide-By-Side (folded) | ﬂ
Printer: | Phaser 850DP M
Delete Job (" Add Blank Page | | Job Settings ( Preview ) ( Standard Printing ) Print

e The Title Bar displays the program title and offers access to minimize and close ClickBook.
e Toolbar offers one-click access to the most commonly used commands.

e Print Jobs displays which applications are going to be printed, the total amount of pages received,
how many copies you want to print, which printer will receive the print job, and allows you to
remove unwanted applications.

e Print Preview provides an idea of what the document will look like when it is printed for the chosen
layout.

e Status Bar allows you to delete an application in the Print Jobs window, add blank pages in
between files, preview the print jobs, and send the applications to the printer.

4.2 Title Bar

The Title Bar displays the program title and offers access to minimize and close ClickBook.

O O ClickBook

4.3 Toolbar

The ClickBook Toolbar offers one click access to frequently used commands.

>/ - & @ N BOOK

irrel Corporati
Welcome Options Setup Layouts Help Blue Squirrel Corporation
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x4

Welcome The Welcome to ClickBook dialog box appears asking you to setup ClickBook to work with
your applications and printers. See The First Time You Run ClickBook.

Optiens  opens the Preferences dialog box where you can change print settings and program
settings.

“EIUP  The Printer Setup dialog box appears, allowing you to setup printers to work with ClickBook.

LaYOULs | qunches the Layouts list window. See Select A Layout.

®

Help Opens the ClickBook Help File where you can learn how to use ClickBook, and find answers
specific questions on ClickBook functions.

4.4 Print Jobs

Print Jobs displays information pertaining to the files received from their corresponding applications. It
also allows you to choose which printer will receive the print job.

Print Document Pages Copies
@ TitlePage.pdf 1 1
™  CI15564.4CourseNotes.pdf 30 1
E Index+References.pdf 66 1

Total Pages: 97

L

Printer: Resource_Center
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The window lists the title and amount of pages, and copies received for each file.

Use your mouse to select a file and click-and-drag the file to rearrange the print order.
Uncheck items in the check mark boxes to remove files from the project.

Total Pages displays the total amount of pages received from all applications.

The Printer drop down menu lists the printers you have setup to work with ClickBook, and the
current chosen printer will receive the print job.

4.5 Print Preview

The Print Preview screen displays the following:

100

Layout: = ISide-By-Side (folded) T‘

¢ Shows you how the selected layout for the Print Jobs will look once it is sent to the printer.
e Drop down menus allow you to select various Layouts.

4.6 Status Bar

The Status Bar provides information pertaining to the current Print Jobs.

Delete Job { Add Blank Page ) | Job Settings ( Preview ) ( Standard Printing ) Print

¢ Delete Job removes a file received in the Print Jobs window.

e Add Blank Page inserts a blank page in between files listed in the Print Jobs Window.

e Preview prints the print jobs to a PDF in the temp folder and opens the Apple's Preview
application. You can view how each page will actually appear before sending it to the printer.

¢ Job Settings launches the Job Settings dialog box where you can specify the number of copies,
and change the name of the item shown in the list.

e Standard Printing sends the print jobs to the printer without applying any layouts.

¢ Print sends the current files that are listed in the Print Jobs to the printer.
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4.7  Options

Select the Options button on the toolbar. The Options dialog appears.

ClickBook Options

{ Print Options | Program Settings

@ Print cut marks
E Print second side instructions

E Print assembly instructions

L- Cancel :,I E—e&-—}

From the Print Options tab you can enable or disable the following features by marking the check

boxes.

o Print Cut Marks - prints cut marks on the printout to use as a guideline for cutting between mini-
pages.

e Print Second Side Instructions - prints out an instruction sheet to reinsert the printout for second-side
printing. This feature comes in handy if you're using a non-duplexing printer.

¢ Print Assembly Instructions - prints out an instruction sheet with guidelines for cutting, folding, and
stapling a printout.

ClickBook Options

" Print Options | Program Settings }

™ Clear Job List After Printing
"1 Automatically Quit After Printing
" Prompt with Print Dialog

Default Units:'_ Inches 4 !

L- Cancel :,I E—Gﬁ-—}

From the Program Settings tab you can enable or disable the following features by marking the check
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boxes.

o Clear Job List After Printing - enabled by default, removes the list of files in the Print
the Main Screen.

o Automatically Quit After Printing - closes ClickBook after the print jobs have been se

Jobs section of

nt to the printer.

e Prompt with Print Dialog - presents the standard Print dialog where you can adjust settings for the
paper tray, borders, and color correction. All of these settings can be set in the Printer Setup area,

so this is useful mostly for people who have a lot of different job types.

o Default Units - chooses a preferred measurement type: centimeters, inches, picas, and points.

Close the Options dialog to save changes.
Layouts

Select the Layouts button on the toolbar. The Layouts dialog appears.

S O6 Layouts

"

Layout Name Show '; New
Avery 41357 organizer pages E d B
Booklet brochure v (_ Edit
CD Jewel Box, Landscape E m |\' Duplicate ',
CD Jewel Box, Portrait o i :
CD Jewel Box 4 | Rename
Classic (cut) E ;
Classic (folded) v ( Delete
Classic Assistant @ -

o [ Import
Classic Filp {folded) E .
Classic Flip {cut) M v Export

¥ Layout Description

This layout was designed to make a folded book for CD Jewel

cases. It has 4 mini-pages to 1 sheet of paper. It is typically used
on documents af 4 to 20 pages. We recommend that you use a 14

pt or larger font size to make your text easier to read. It can be
used to print software manuals, readme files, song lists, etc. Each

mini-page is 4 5/8" tall and 4 5/8" wide.

From the Layouts dialog you can:

¢ Layout Name/Show - mark/unmark check boxes for Layouts you would like to see displayed in the

scroll list located under the Print Preview.
e Layout Description - provides you with common uses for the selected layout.
¢ New - launches the Modify Layout dialog and allows you to create a new layout.
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Edit - launches the Modify Layout dialog and allows you to alter an existing layout.
Duplicate - builds an identical copy of an existing layout.

Rename - changes the name of a layout.

Delete - removes a layout from ClickBook.

Import - add custom layouts from other users. Visit
http://www.bluesquirrel.com/clickbook/layouts.asp for a list of new layouts.

e Export - send layouts to other users.

49  Preview
Preview, located on the Status Bar prints the print jobs to a PDF in a temporary folder and opens

Apple's Preview application. You can view how each page will actually appear before sending it to the
printer.

Delete Jeb | [ Add Blank Page | ' Preview-_.' Standard Printing ' ( Print )

Select Preview on the Status bar, Apples Preview application opens.

606 ¢ Preview of “ClickBook".pdf (&6 Pages) =
| + - )
4 b wr — + | A S
= 1 t | L X
Drawer Back/Forward Page (of 6) Page Up Page Down Zoom In  Zoom Out Tool Mode

APT E EEVISION MISTORY
CoDataPrrader Ralssncs

P arwinr Danrptiers

Document Revision History

LTI
Vwailahile i Mlar O X vorsien

Haszin

@Soft Proof ( Cancel ) ( Print }

Drawer - opens a sliding side panel showing a preview of all the pages in the document.
Back/Forward - scroll through each page.

Zoom In and Zoom Out - increase or decrease the documents magnification.

Page textbox - enter a page number to view a particular page.

Page Up and Page Down - move to the next physical page.
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Tool Mode - insert text in the document, select an area of the document for copying, or navigate the
page.

Soft Proof - mark or unmark the checkbox to view and print a gray scale version of the document.
Print - send the print job to the printer.

Cancel - closes the Preview dialog.

Note: If you have a duplex printer the Preview screen will combine the fronts and backs into a single
file.

If you have a non-duplexing printer the fronts will go into one file and the backs will go into another,
allowing you to print double-sided independent of ClickBook.

Printing With ClickBook
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5.1  Printing Any Document

The instructions below tell how to print any document with ClickBook. If you select a layout with small
mini-pages, you may wish to enlarge the document's fonts in your application program.

These instructions include all the steps necessary for printing double-sided small books, the most
complicated kind of booklet. The layout you're using may be simpler.

1. Prepare your document as you normally would in your application program.

2. Print the document to ClickBook by proceeding with the following steps.

3. Ensure that ClickBook is active. This can be done by seeing if the "Use ClickBook" check box in
the Page Setup dialog is checked, or by choosing the "ClickBook Always Active" option in the
ClickBook Setup control panel.

4. Select Print from the File menu. The Print dialog will appear.

5. Inthe Print dialog select the PDF button. A pop up menu appears, choose Open PDF with
ClickBook.

6. After you have given the print command from your application program, your application will print
your document to ClickBook. Once your application has finished printing, the ClickBook software
will pop up.

7. Choose a layout in ClickBook to specify the appearance of your printed booklet.

8. Then click Print from ClickBook to print your document as a booklet.

9. The first sides will begin to print. If you're using a duplexing printer you will not need to follow the
proceeding steps.

7. When the last sheet of paper has printed, remove the printout stack carefully, without rearranging
the sheets. Discard any extraneous sheets (such as separator sheets on a shared network
printer), but leave the instruction sheet as part of the printout.

8. Read the instruction sheet -- without lifting it off the other sheets and place the printout back into
the printer according to the instructions. If this printer prints an extraneous sheet before each print
job, place a blank sheet on top of the printout stack.

9. Click on the Print Second Side button to begin printing the second sides.

10. When printing is completed, remove the printout. Discard extraneous sheets, if any, and set aside
the instruction sheet. Do not rearrange the rest of the printout stack in any way.

11. Fold and/or bind the booklet.

ClickBook reduces the document to fit the selected layout and sends it to the printer. If you chose a
double-sided layout, an optional instruction sheet may be printed, telling you how to reinsert the printout
stack for printing the second side.

Optionally, you can print instructions for cutting paper and assembling the booklet that will print on the
reverse side of the instruction sheet. These will instruct you to cut and assemble for a wallet size
layout, and can be applied generally for other cut-booklet layouts. Binding and stapling or any other
method is your choice. (To print the instructions, turn on the "Print assembly instructions" option on the
Printing Options tab before printing your booklet.)

5.2  Printing A Booklet
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5.3

We recommend that you work through the following ClickBook exercise before exploring ClickBook on
your own.

"Printing a booklet", leads you through the whole process of printing a booklet. The document it prints
is the ClickBook Readme (Text) file, which contains important information about ClickBook. It is simple
to print because it is short in length and its fonts are pre-sized for the default layout. This layout is also
simple to assemble -- you just fold and staple.

This document will print double-sided, with two pages on each side of a sheet of paper. You will fold it
once to make a half-size booklet. Follow these steps:

1. Ensure your printer is on-line and ready to print with letter-size (8-1/2" x 11") paper.

2. Open the file ClickBook Readme (Text) that was copied into your ClickBook folder when you
installed ClickBook.

3. Make sure that ClickBook is active. This can be done by seeing if the "Use ClickBook" check box
in the Page Setup dialog is checked, or by choosing the "ClickBook Always Active" option in the
ClickBook Setup control panel.

4. Select Print from the File menu. The Print dialog will appear.

5. Inthe Print dialog select the PDF button. A pop up menu appears, choose Open PDF with
ClickBook.

6. Note that the Side-by-Side (folded) layout is already selected on the Layout list. ClickBook
remembers the most recent layout selected for each document, and we pre-selected Side-by-Side
(folded) when we created this document. (You can see what all of the layouts look like by clicking
repeatedly on the illustration, the layout's name is shown below its picture in the layout list.)

7. Click the Print button. The first sides will begin to print. If you're using a duplexing printer your
printout will come out of the printer finished.

8. When the last sheet of paper has printed, remove the printout stack carefully, without rearranging
the sheets. Discard any extraneous sheets (such as separator sheets on a shared network
printer), but leave the instruction sheet as part of the printout.

9. Read the instruction sheet -- without lifting it off the other sheets and place the printout back into
the printer according to the instructions. If this printer prints an extraneous sheet before each print
job, place a blank sheet on top of the printout stack.

10. Click on the Print Second Side button to begin printing the second sides.

11. When printing is completed, remove the printout. Discard extraneous sheets, if any, and set aside
the instruction sheet, but do not rearrange the rest of the printout stack in any way.

12. Fold in half, and staple.

Drag and Drop Printing

The instructions below tell you how to quickly print PDF files with ClickBook. Depending on the layout
you choose, your document may require special formatting in your application program to look its best.

1. Ensure your printer is on-line and ready to print with letter-size (8-1/2" x 11") paper.

2. Drag the PDF file you desire to print onto the ClickBook Dock icon. You may also Drag the PDF
file onto ClickBook's job list.

3. ClickBook will open.

4. Note that the Side-by-Side (folded) layout is already selected on the Layout list. ClickBook
remembers the most recent layout selected for each document, and we pre-selected Side-by-Side
(folded) when we created this document. (You can see what all of the layouts look like by clicking
repeatedly on the illustration, the layout's name is shown below its picture in the layout list.)

5. Click the Print button. The first sides will begin to print. If you're using a duplexing printer your
printout will come out of the printer finished.

6. When the last sheet of paper has printed, remove the printout stack carefully, without rearranging
the sheets. Discard any extraneous sheets (such as separator sheets on a shared network
printer), but leave the instruction sheet as part of the printout.

7. Read the instruction sheet -- without lifting it off the other sheets and place the printout back into
the printer according to the instructions. If this printer prints an extraneous sheet before each print
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job, place a blank sheet on top of the printout stack.

8. Click on the Print Second Side button to begin printing the second sides.

9.  When printing is completed, remove the printout. Discard extraneous sheets, if any, and set aside
the instruction sheet, but do not rearrange the rest of the printout stack in any way.

10. Fold in half, and staple.

Note: You'll need to ensure that ClickBook is setup on your Dock. Refer to Run the Setup Program.

5.4  Reinsterting The Printout Stack Before Printing The Second Side

The critical step of double-sided printing is correctly reinserting the first-side print out correctly into the
printer so the second side can be printed. Each detail of this process is important:

e When you are certain that all of the sheets from the first-side printout are done, remove the
printout stack from the printer without rearranging the pages. Make certain. If any other print jobs
were sent to this printer, that you are holding only your intended printout. If you're on a network
and a printer prints an extra sheet (blank, or with network user id, for example) between printouts,
throw out that sheet.

e Turn the stack over if necessary to find the instruction sheet. Read the instruction sheet without
lifting it off the stack.

¢ Reinsert the stack with the instruction sheet still on it.

¢ If your printer puts out an extraneous sheet before each print job ( e.g. printout separator sheets
on network printer), place a blank sheet on top after reinserting the stack. If the printer went
offline when you reinserted the stack, put it back online.

55 Assembling A Book

To turn on the Assembly Instructions:

Open ClickBook.

Choose Options from the toolbar.

Select the Print Options tab and mark the check box next to Print Assembly Instructions.
Close the Window to save your changes.

Note: by default, ClickBook will automatically print the Assembly Instructions with your printout.

5.6 Assembling And Cutting A Book

For layouts that require cutting and assembling the printout to form a book, instructions can be printed
with your printout. The same instructions are given below. Note to print these instructions with each
booklet, click on the Options button and turn on the Print assembly instructions option.

The cut marks on the printout are guidelines that show between which mini-pages to cut. Their
position is accurate to about 1/16", which is not high precision for very small mini-pages. Use your eye
or measure, in order to cut precisely halfway between mini-pages.

The marks themselves tell you the order of the cuts. The solid line indicates the first cut, the line
composed of two dashes indicates the second, the line composed of three dashes indicates the third,
and so on.

The instructions below, or those printed with the printout, include the important information about how

to re-stack the cut sheets after each cut. They give the general rules for cutting and assembling any
book of any layout.

1. If the mini-pages do not fill the sheet (that is, if you specified absolute mini-page dimensions), the
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first step is to cut away the extra paper. If there is no extra to cut away, skip to step 4.

2. Cut at the "one-dash" cut mark, which indicates a vertical cut to eliminate extra paper on the right.
Discard the extraneous strips.

3. Cut at the "two dash" cut mark, which indicates a horizontal cut to eliminate extra paper at the
bottom. Discard the extraneous strips.

4. Make the leftmost vertical cut. (Look for the next cut mark. Depending on whether you did steps
1.a. and/or 1.b., this may be composed of one, two or three dashes.)

5.  Now your printout is split into two stacks. Place the one with page 1 on top of the other, aligning
the top left corners.

6. Make the leftmost remaining vertical cut, if any.

7. Again, place the page 1 stack on top of the other, with top left corners together.

8. Continue in the same way until all vertical cuts have been made.

9. Make the top horizontal cut.

10. Place the page 1 stack on top of the other, with top left corners together.

11. Make the topmost remaining horizontal cut if any.

12. Place the page 1 stack on top of the other, with the top left corners together.

13. Continue in the same way until all horizontal cuts have been made.

14. Be sure to fold and/or bind on the edge indicated by your choice of layout, namely binding on the
left for a Standard book, or on top for a Flip book. For a folded booklet layout: Remove blank mini-
sheets, if any, from the middle. Fold in half and staple. For a cut book layout: Remove blank mini-
pages, if any from the end. Then bind.

Stapling and Paper cutting recommendations

STAPLING

Problem: Standard staplers may not reach the fold on larger booklets, or the staples may go in
crooked.

Solutions

¢ A'long-reach" stapler, available from Blue Squirrel, provides a good solution. We've used the
Stanley-Bostitch Long Reach Stapler with excellent results on all our folded layouts.

¢ Another good solution is the Stanley-Bostitch Booklet "saddle" stapler. A folded booklet (up to 8-1/2"
x 11" when flat) slips into place on the stapler and staples straight every time.

Tip: Be careful to staple with outside of the booklet facing you, so that the sharp side of the staple will
be on the inside! Call 800-403-0925 or visit http://www.bluesquirrel.com/clickbook/staplers.asp for
information about staplers.

PAPER CUTTING
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Problem:
e On most paper cutters, there is some play (sideways motion) in the cutting arm, which makes it hard
to cut a perfectly squared edge (making right angles at the corners).

Solutions

e As you lower the cutting arm, press slightly inward (to the left) to keep the blade tight against the
base of the paper cutter.

o Arolling-blade paper cutter does an excellent job of timming booklets. Visit Blue Squirrel for
information about the Dahle 507 Hobby Trimmer, and Dahle 360 Trim Ruler. Both allow you to
precisely cut booklets with clean-crisp, burr-free cuts. Includes blade covers for safety, self
sharpening blades, and comes in handy when you want to neatly removes the shingling effect from
folded books. Call 800-403-0925 for information, or visit: http://www.bluesquirrel.com/so/trimmer/.

5.8 Setting Margins And Binding Space

Margins
Paper margins allow you to change the margins for a sheet of paper, and Mini-Page margins allow you
to change the mini-page margins for the current Layout.

¢ ClickBook's margins are in addition to the margins set in your application program.
¢ Unlike the application program's margins, which gets scaled down along with the contents of your
document, ClickBook's margins print at the exact size specified.

Binding
The Binding margin is extra space only on the side where the book will be bound. You can adjust the
following:

e Printer Paper Size - Select the size of paper you want to use.

¢ Binding - Choose how you want the binding edge.

To change either margins or binding follow these steps:

1. From the Toolbar select Layouts, the Layouts dialog appears.

2. Under the Margins section alter the settings to your liking by using up and down arrows on the
number boxes.

3.  When you are finished, press OK.

Note: Usually you should set your application program's page margins or ClickBook's Top/Bottom and
Left/Right Mini-page Margins. If you choose to set ClickBook's we recommend that you first print a
part of your booklet and measure the exact of margin you want to add. Then print the entire document
with the Mini-page margins set correctly.

Note: Set the Paper Margins to match the cut-away or pre-perforated tear-off areas around the edges
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of some custom papers.

Layouts

What is a Layout?

A layout is a blueprint for a particular booklet, which is defined by a group of detailed settings that tell
ClickBook how to arrange the mini-pages on a sheet of paper. Some of the essential details are
whether the paper orientation is portrait or landscape, how many mini-pages are printed across and
down on one sheet, whether to print single or double-sided, margin sizes, and added space for binding.

Booklet Styles

Each layout also has a certain booklet style. This relates to how you intend to assemble and bind the
booklet, and tells ClickBook the order to print the mini-pages so they will end up in the right order in
your finished booklet. There are six booklet styles: Cut book, Folded book, French fold, Planner
pages, Tiled, and Tri-fold. You can determine a layout's booklet style by its name, the corresponding
picture, and by looking at the Booklet Style in the Modify Layouts tab.

e Cut book Layouts are for methods of binding that require cutting between facing pages. Most of the
cut book layouts shipped with ClickBook are designed for paper that's pre-perforated for a custom
appointment-book page.

o Folded book Layouts are designed for folding between facing pages, and stapling. Examples
include the "Address book (folded)", "Wallet book (folded)", and "Side-by-side (folded)" layouts.

¢ French fold layouts are for making greeting cards from standard paper by folding the printed sheet in
fourths. The French fold style expects exactly four pages per sheet.

o Planner page Layouts are designed for day planner paper that has holes on the left and right hand
sides.

o Tiled layouts are designed for multiple pages on a sheet but not cutting the sheet. The sheets that
come out of the printer are the final sheets. There are two sequences in which the mini-pages can
be printed in a tiled layout. These are controlled by the Binding Orientation options in the
Modify Layout dialog.
¢ Row-wise means page 2 prints to the right of page 1. For row-wise order, select the Standard

binding orientation.
e Column-wise means pages 2 prints below of page 1. For column-wise order, select the Flip
binding orientation.

o Tri-fold Layouts are for printing single-sheet brochures or leaflets which are folded twice, making
three panels (mini-pages) on each side of the paper. The tri-fold style expects exactly six pages per
brochure, since this style of brochure is a single sheet of paper, folded. Tri-fold pagination places
pages 5, 6, and 1 on one side, and pages 2, 3, and 4 on the other side. The front panel is thus page
1, and the reader opens up the brochure to see pages 2, 3, and 4 inside, and then turns the sheet
over to read pages 5 and 6.

Select A Layout
Answering the following series of questions will help you decide which layout you want.

¢ Is your document oriented as portrait or landscape? You should choose a layout that orients the
mini-pages in the same way. Look at the picture for each layout to determine its mini-page
orientation. (ClickBook will warn you if you choose a layout that doesn't match.

e What sort of booklet do you want to print?

¢ How large do you want your finished mini-pages to be? Mini-pages determine how many sheets
of paper you want to include on a single sheet of paper, and how to fit them on the size of paper
you're using. For examples look through the tiled or booklet layouts. To choose a layout with an
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appropriate number of mini-pages, look at the print preview picture.

e What size do you want your fonts and graphics to appear? Small booklets usually require that you
enlarge the fonts and graphics, unless you choose to use No Scaling. If you choose No Scaling
enlargement must be done in your application program and then print the document to ClickBook
again. If you want to enlarge the fonts we recommend adjusting the mini-pages.

Note: Refer to Scaling Options for helpful hints on scaling booklets.

See Create New/Edit/Delete Layouts for instructions on altering a Layout.

To Select a Layout follow these steps:

1. Follow Steps 1-6 in the Printing Any Document section.
2. Click on the Layouts button on the Toolbar.

3. The Layouts dialog appears.

e O6 Layouts

Layout Name Show ' New '
Avery 41357 organizer pages E Al _
Booklet brochure 4 (__ Edit )
CD Jewel Box, Landscape 4 ( Duplicate )
CD Jewel Box, Portrait E y i
CD Jewel Box 4 ( Rename
Classic (cur) E . _
Classic (folded) v (_ Delete )
Classic Assistant @ ; :
o ( Import )
Classic Filp {folded) v . .
Classic Flip {cut) ¥ v Export )

¥ Layout Description

This layout was designed to make a folded book for CD Jewel
cases. It has 4 mini-pages to 1 sheet of paper. It is typically used
on documents af 4 to 20 pages. We recommend that you use a 14
pt or larger font size to make your text easier to read. It can be
used to print software manuals, readme files, song lists, etc. Each
mini-page is 4 5/8" tall and 4 5/8" wide.

4. Scroll through the list to determine which layout you would like to print. As you select layouts the
Layout description displays common uses for that particular layout.
5. Close the dialog to save your changes.
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6.2 Layout Settings

The Layout Settings dialog box allows the user to make permanent changes to any layout format. It
also allows the user to save their changes as a new layout by selecting Save As or to save their
changes over an existing layout by clicking done.

Layout Settings

Layout Name: CD Jewel Box, Portrait Units: ' Default v
ClickBook Style Binding
@ |
@ Folded Book *) Standard |
") Cut Book _ Flip . |
) Tiled g
: Tri-fold Print Sides L i — i _1 — J
) Single-sided
) Double-sided

Scaling Mini Pages
— @ Use Absolute Dimensions
_ Auto-scale
_ Preserve Shapes Across: 2 = Width: 4.68" I
@ No scaling : =
Down: 1 = Height: 4.68" -
Maragins Layout Description
Binding: '0,, 1 (= ‘This layout was designed to make a folded book for CD

|4

Jewel cases. It has 4 mini-pages to 1 sheet of paper. It is
typically used on documents of 4 to 20 pages. We
recommend that you use a 14 pt or larger font size to make

.................. #m rnad I ran ke arnd fa meind cafRaen

Top/Bottom: 0"

(4

¥

Left/Right: ('

|4

|___' Page Setup '__| . Cancel l ( OK )

Layout Name - Displays the name of the layout selected.
Units - Choose measurement type as inches, centimeters, points, and picas.
ClickBook Style:
e Booklet Type - Select a booklet style such as Cut book, Folded book, Tiled, and Tri-fold.
Mini Pages
e Mini-pgs. on Sheet - Select how many pages to put on a single sheet of paper.
e Absolute Dimensions - ClickBook sets the Mini-page dimensions to fill a sheet of paper. You
can set the dimensions by turning on Absolute Dimensions.
o Width - Specify the width to match a custom page size.
Height - Specify the height to match a custom page size.
Binding
e Standard - Pages of book will turn side to side.
o Flip - Pages of book will flip up.
Page Setup
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e Sheet Orientation - Select if you want the sheet to print in Portrait or Landscape Orientation.
e Printer Paper Size - Select the size of paper you want to use. This will override the default
setting that is under Tools->Options.
e Scaling
e Scaling - Choose the type of scaling to use, either Auto-Scale (stretch-to-fit), Preserve Shapes
(One to One), No Scaling.
e Margins
e Binding Edge - Choose how you want the binding edge:
e Paper Margins - Allows you to change the margins for a sheet of paper.
e Layout Description - Provides you with common uses for the selected layout.
e OK - Saves any changes made to the current Layout.
e Cancel - Closes the Modify Layouts dialog.

6.3  Create New/Edit/Delete Layouts
To edit, duplicate, or create a new Layout follow these steps:

Making a backup

For backup purposes, you may want to save all the original layouts before making many changes to
them. You can do this by exporting the ones that you are going to change. Then, if you ever need to
revert to the originals, just import the layouts.

It's best to save a changed layout with a new name if you may want the original version in the future.
The following steps overwrite the original.

To Edit a Layout:

Open the ClickBook application.

Choose the Layouts button on the toolbar.

The Layouts Dialog will appear.

Choose the desired layout and press Edit. The Layout Settings dialog appears.
Make the changes you want.

Save the layout under its current name by clicking the OK button.

ocoukrwpbpE

After making changes but before saving them, you can click Cancel. This reverses all changes made
since you last saved the layout.

To Duplicate a Layout:

Open the ClickBook application.

Choose the Layouts button on the toolbar.

The Layouts Dialog will appear.

Select desired layouts and press Duplicate.

The Duplicated Layouts will appear in the list. You can edit and rename them as you wish.

akrwdpE

To create a New Layout:

Open the ClickBook application.

Choose the Layouts button on the toolbar.

The Layouts Dialog will appear.

Click the New option. The Layout Settings dialog appears.

Type the name in the Layout Name text box.

Make the changes you want.

Save the layout under its current name by clicking the OK button.

Nogr~wNhE

Notes on specific settings
Some important details about particular settings are given below. See Modify Layout for a
descriptions of all the settings.
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6.4

Mini- pages Across and Down, and absolute mini-page Width and Height
If you have selected No scaling, then you must make sure that the page size setting in your
application exactly matches (or fits within) the mini-page size. With No scaling on, ClickBook
prints one application page on one mini-page without shrinking the data, leaving you to set up
the application page exactly as you want it to print and to match the mini-page size.

You must set the number of mini-pages Across and Down.

ClickBook automatically sets the mini-page Width and Height to the maximum size that will fit
on a sheet. Optionally, you can turn on Use Absolute Dimensions, and then decrease Width
and Height to fit a custom page size.

Paper size (in the Page Setup dialog)
This is the size of paper (physical sheets) you're using. Note: This is not to be confused with the
application program's paper size setting, which is unrelated (when scaling is used).

Note about mini-page orientation

The selected layout's mini-pages and your document's pages (in its application program) should have
the same orientation (portrait or landscape). If ClickBook must scale the document's pages to fit an
extremely different page shape, the shape of the text or graphics will end up very distorted. Therefore
ClickBook warns you if a layout is selected whose mini-page orientation doesn't match your document
pages.

However, you can ignore this warning if you're sure you want to use the selected layout. For example,
you may have defined your document's page size in the application program to be almost square (but
just barely portrait), while the layout's mini-pages are also almost square (but just barely landscape).
This will work okay.

Note that the mini-page/document page orientation is independent of the orientation of the sheet of
paper (the Sheet Orientation).

Import/Export Layouts

Import and Export
If you want to add an existing layout to ClickBook, or if you have a favorite layout that you would like to
share, you can use the Import and Export buttons.

Import:

1. Toimport a layout choose the Layout button on the toolbar.

2. The Layouts dialog will appear.

3. Click the Import button.

4. Navigate to the location of the layout that you want to add to ClickBook (floppy, hard disk, server,
etc.), and then click Open. You can immediately start using the new layout.

Export:

1. To export a layout choose the Layout button on the toolbar.

2. The Layouts dialog will appear.

3. Select the one you wish to export, and then click the Export button.

4. Navigate to where you want to save the layout (floppy, hard disk, server, etc.), and then click
Save. You can change the name of the saved layout, if you wish.

Note: You can import/Export by dragging and dropping files from the ClickBook Layout list.
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7.1

7.2

Borders

1. Launch the ClickBook application (this can be done from your Hard Drive, or by printing to
ClickBook from an application).

2. Select the Setup button on the ClickBook toolbar.

3. Choose the printer you want to setup from the Printer drop-down list. (If you have more than one
printer they will be displayed in the Printer drop-down list.)

4. Click on the Print Setup button, choose Layout from the drop down menu.

5. Select the type of Border you want from the drop down menu, i.e., single hairline, single thin line,
double hairline, double thin line.

6. To save your changes press the Print button.

Manual Printer Setup

The Manual Printer Setup option lets you answer some questions to provide information to ClickBook
about your printer and how it handles paper. If you click on the Check Website button you'll be
directed to http://www.bluesquirrel.com/clickbook/printersetup/ where other ClickBook users have
provided the configuration that worked for their printer.
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Printer Setup

Printer: | Resource_Center y
Defined as: HP Laser)et 4050 Series

Easy | Manual | Custom  Help

Check our website to see if we have a setting defined for your printer. If so,
you may enter the value in the Setting field, below. (The number must be
between 0 and 31 and will automatically set the other controls.) If we don't
have the parameters for your printer, try using the Custom Setup assistant
to help ClickBook determine the way your printer works.

f_ Check Website \ Setting: 23 :
@ Pages Print In Order @ Paper feeds from Top of Stack
E Page Fronts print Face Up ! Paper feeds head of page first

For Landscape, Printer rotates paper
) 90° to the Left ) 90° to the Right

( Print Setup ) ( Cancel ) ( 0K )

1. Make sure the printer you wish to set up is ready to print (turned on, on-line, paper loaded,
selected in your Chooser, etc.)

2. Launch the ClickBook application (this can be done from your Hard Drive, or by printing to
ClickBook from an application).

3. Select the Setup button on the ClickBook toolbar.

4. Read the text displayed on the tab.

5. Choose the printer you want to setup from the Printer drop-down list. (If you have more than one
printer they will be displayed in the Printer drop-down list.)

6. Select the Manual Printer Setup button.

7. Click the Check Website button, which will launch your Web browser and open the Blue Squirrel
Web Site http://www.bluesquirrel.com/clickbook/printersetup/. The online list contains several user
contributed printers. Choose your printer and press the Lookup button to see a value displayed.

8. Enter the value in the Setting text field.

9. You may also answer the questions if you understand how your printer prints.

10. If you have a duplexing printer, click on the Print Setup button, choose Layout from the drop down
menu and choose the radio button for Two Sided Printing.

11. Press OK when you are done.
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7.3 Add Blank Page
This feature may come in handy when you want to add a blank page in between print jobs. You can
easily do so by clicking on the Add Blank Page button on the Status Bar.
" Add Blank Page ‘
When you click on the Add Blank Page button a file will appear in the Print Jobs window. You can drag
and drop files to rearrange the print order, and you can uncheck files you do not wish to print.
7.4  Rearrange print order
We recommend printing from the applications in the order you want ClickBook to print. You can drag &
drop files up and down to rearrange the print order. If you drag upwards, the moved items are placed
before the dropped-on item. If you drag downwards, the moved items are placed after the dropped-on
item. You can also unmark the check box next to the corresponding file you do not want sent to the
printer.
Print Document Pages Copies
v TitlePage.pdf 1 1
™  C15564.4CourseNotes.pdf 30 1
.E! Index+References.pdf 66 1
Select and drag filez up or down
with pour mouze to rearange the
print arder.
Total Pages: 97
Printer: Resource_Center 3
7.5 Scaling Options

The three scaling options in the Layout Settings dialog box enable you to control how and whether
ClickBook shrinks (scales) the pages of your document. The Scaling options are: Auto-Scale,
Preserve Shapes, and No Scaling.

Auto-Scale

Auto-Scale is the scaling setting for most of the ClickBook layouts. When a layout has Auto-Scale on,
ClickBook receives the document pages from your application program and scales (shrinks) as
necessary to fit on the layout's mini-page size. When you use Auto-Scale, be sure to set the fonts
large enough in the application program to be readable after they're scaled down.

Preserving the shape of graphics and text

As ClickBook shrinks the pages of your document down to the mini-page dimensions of the selected
layout, the shape of the page may change substantially. In such cases, the shape of the fonts and
graphics may be excessively changed.
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Preserve Shapes

To prevent this, select the One-to-one option in Modify layout. ClickBook will then shrink the pages
proportionately without altering their shape. The resulting text or graphics will be somewhat smaller
than with Auto-Scale, and each mini-page will have some extra white space.

No Scaling

Do-it-yourself: The No Scaling option

If you wish to print text and graphics at exactly the size you've prepared them in the application
program, select the No scaling option. With No scaling on. ClickBook prints one application page on
one mini-page without shrinking the data, leaving you to set up the application page exactly as you
want it to print.

This option often solves problems that may occur with scaling.

Before printing a document with No scaling, prepare it as follows in the application program:

¢ Set fonts to the actual size you want them in the printout.
e Set the document's page size (in the application program) to match the mini-page size (of the
ClickBook layout you plan to use).

You must make certain that the document's page size is smaller than or the same as the layout's mini-
page size. Unless you have a reason to do otherwise, set the page size to exactly match the mini-
page size. You can set it by either setting the page dimension settings, or by changing the margins so
that the data area has the desired dimensions.

Note: In some applications it is necessary to use margin settings to accomplish this.

7.6  Missing Files Screen

If you receive the following dialog when you open ClickBook, it is because the print jobs are stored in a
temporary folder, and tend to be deleted by the system when you login, logout, or reboot your
computer. You may also see this dialog if you drag a document into the print job list and delete, move,
or rename the file. Simply press OK to close the dialog.

The following files have been deleted from the
temportary files folder and were lost:
Appendix.pdf

This can happen after a re-boot or after a logout/
login. Try re-printing them from their host
application.
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Note: You will need to resend the files to ClickBook in order to print.

Glossary

e Aspect Ratio - The ratio of width to height. If the aspect ratio changes then photographs can
appear stretched or squeezed.

e Auto-Scale - Stretches the source document to fit the new area. If the area is not the same shape,
the document may need to be stretched more in one direction. This is usually fine for text, but leads
to photos that may look stretched or squeezed.

e Binding Edge - A standard binding edge is for right/left. A flip binding edge is for folding top/bottom.

e Crop - Cropping chops off portions of a document.

e Duplex - Printing on both sides of the paper. Many printers include a duplexer that allows the printer
to print on both sides of the paper without human intervention. ClickBook supports printers with
duplexers.

e Landscape - A paper orientation where the words on the page are going across the long edge of the
paper. See Portrait.

e Layout - A specific configuration of ClickBook that turns a print out in to a poster, booklet, card,
brochure, etc.

e Mini-Pages - The area on a piece of paper that the source document pages will be placed.
Example: One piece of paper would have 4 mini-pages for a folded booklet. Two mini-pages on
each side of the piece of paper.

o Portrait - A paper orientation where the words on the page are going across the short edge of the
paper. See Landscape.

e Preserve Shapes - A Scaling option that keeps the shape. This scaling option is better for photos.

e Sample Document - A document that works with a set of layouts. The many samples included with
ClickBook show how the document works with ClickBook to create a print out.

e Scaling - Stretching or shrinking a document to fit an area on a piece of paper. One-to-one scaling

QB LUE
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If you are having difficulties using ClickBook, please check the following:

Support

The problem may be with the printer. See whether the problem still occurs when you (A) print without
ClickBook, or (B) print on a different printer. If the problem still occurs in case A, or goes away in case
B, the problem is with your printer or its driver. The first possible solution is to get a newer printer
driver. If no newer driver is available, or using the latest one does not solve the problem, contact the
manufacturer or vendor of your printer.

Frequently, problems observed in applications actually are based in the operating system. Does your
problem occur in other applications as well? Do any other symptoms suggest that the problem may be
in Windows? If so, you need Windows technical support.

Browse through the accompanying program help file for any late breaking information about ClickBook,
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and using ClickBook with specific software or hardware. You can access the Help file by going to ...

Visit Our Web Site

If you cannot find the information you need in any of the preceding sources, contact us at our Web site.
Please refer to ClickBook's support and FAQs for frequently asked questions.
http://www.bluesquirrel.com/support/

Contact Us
If you would like to speak with a Blue Squirrel representative regarding a non-technical question please
call Customer Service at:

Customer Service

Toll Free: 800-403-0925
Telephone: 801-352-1551

Fax: 801-912-6032

E-mail: sales@bluesquirrel.com

Note: Hours are: 8:00 a.m. to 5:00 p.m. Mountain Standard Time.

Mailing address
Blue Squirrel

686 E. 8400 South
Sandy, UT 84070

10 License

THE BLUE SQUIRREL END USER LICENSE AGREEMENT REDISTRIBUTION NOT
PERMITTED

GRANT. Subject to payment of applicable license fees, Blue Squirrel grants you a non-exclusive license to use the Software and accompanying
documentation ("Documentation”) in the manner described below under "Scope of Grant."
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SCOPE OF GRANT
You may:
e use the Software on any single computer;
« use the Software on a network, provided that each person accessing the Software through the network must have a copy licensed to that
person;
e use the Software on a second computer so long as only one copy is used at a time;
e copy the Software for archival purposes, provided any copy must contain all of the original Software's proprietary notices; or
o if you have purchased licenses for a 10 Pack or a 50 Pack, make up to 10 or 50 copies, respectively, of the Software (but not the
documentation), provided any copy must contain all of the original Software's proprietary notices. The number of copies is the total number of
copies that may be made for all platforms. Additional copies of Documentation may be purchased.

You may not:
e permit other individuals to use the Software except under the terms listed above;
e permit concurrent use of the Software;
« modify, translate, reverse engineer, decompile, disassemble (except to the extent applicable laws specifically prohibit such restriction), or
create derivative works based on the Software;
e copy the Software other than as specified above;
e rent, lease, grant a security interest in, or otherwise transfer rights to the Software; or
e remove any proprietary notices or labels on the Software.

LIMITED WARRANTY.

Blue Squirrel warrants that for a period of ninety (90) days from the date of acquisition, the Software, if operated as directed, will substantially
achieve the functionality described in the Documentation. Blue Squirrel does not warrant, however, that your use of the Software will be
uninterrupted or that the operation of the Software will be error-free or secure. In addition, you must determine that the Software sufficiently meets
your requirements. Blue Squirrel also warrants that the media containing the Software, if provided by Blue Squirrel, is free from defects in material
and workmanship and will so remain for ninety (90) days from the date you acquired the Software. Blue Squirrel's sole liability for any breach of this
warranty shall be, in Blue Squirrel's sole discretion; (i) to replace your defective media; or (ii) to advise you how to achieve substantially the same
functionality with the Software as described in the Documentation through a procedure different from that set forth in the Documentation; or (iii) if the
above remedies are impracticable, to refund the license fee paid for the Software. Repaired, corrected, or replaced Software and Documentation
shall be covered by this limited warranty for the period remaining under the warranty that covered the original Software, or if longer, for thirty (30)
days after the date (a) of shipment to you of the repaired or replaced Software, or (b) Blue Squirrel advised you how to operate the Software so as to
achieve the functionality described in the Documentation. Only if you inform Blue Squirrel of your problem with the Software during the applicable
warranty period and provide evidence of the date you purchased a license to the Software will Blue Squirrel be obligated to honor this warranty.

Blue Squirrel will use reasonable commercial efforts to repair, replace, advise or, refund pursuant to the foregoing warranty within 30 days of being
so notified. IF THE SOFTWARE IS INCLUDED AS PART OF A LARGER BUNDLE, SOME OF THESE REMEDIES MAY NOT BE AVAILABLE TO
YOU.

THIS IS A LIMITED WARRANTY AND IT IS THE ONLY WARRANTY MADE BY BLUE SQUIRREL. BLUE SQUIRREL MAKES NO OTHER
EXPRESS WARRANTY AND NO WARRANTY OF NONINFRINGEMENT OF THIRD PARTIES' RIGHTS. THE DURATION OF IMPLIED
WARRANTIES, INCLUDING WITHOUT LIMITATION, WARRANTIES OF MERCHANTABILITY AND OF FITNESS FOR A PARTICULAR
PURPOSE, IS LIMITED TO THE ABOVE LIMITED WARRANTY PERIOD; SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW
LONG AN IMPLIED WARRANTY LASTS, SO LIMITATIONS MAY NOT APPLY TO YOU. NO BLUE SQUIRREL DEALER, AGENT, OR
EMPLOYEE IS AUTHORIZED TO MAKE ANY MODIFICATIONS, EXTENSIONS, OR ADDITIONS TO THIS WARRANTY. If any modifications are
made to the Software by you during the warranty period; if the media is subjected to accident, abuse, or improper use; or if you violate the terms of
this Agreement, then this warranty shall immediately be terminated. This warranty shall not apply if the Software is used on or in conjunction with
hardware or software other than the unmodified version of hardware and software with which the software was designed to be used as described in
the Documentation.

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT VARY BY JURISDICTION.

TITLE. Title, ownership rights, and intellectual property rights in the Software shall remain in Blue Squirrel and/or its suppliers. The Software is
protected by the copyright laws and treaties. Title and related rights in the content accessed through the Software is the property of the applicable
content owner and may be protected by applicable law. This License gives you no rights to such content.

TERMINATION. The license will terminate automatically if you fail to comply with the limitations described herein. On termination, you must destroy
all copies of the Software and Documentation.

LIMITATION OF LIABILITY. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT, OR OTHERWISE SHALL
BLUE SQUIRREL OR ITS SUPPLIERS OR RESELLERS BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF
GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR
LOSSES. IN NO EVENT WILL BLUE SQUIRREL BE LIABLE FOR ANY DAMAGES IN EXCESS OF THE AMOUNT BLUE SQUIRREL
RECEIVED FROM YOU FOR A LICENSE TO THE SOFTWARE, EVEN IF BLUE SQUIRREL SHALL HAVE BEEN INFORMED OF THE
POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO
LIABILITY FOR DEATH OR PERSONAL INJURY TO THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. FURTHERMORE,
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS
LIMITATION AND EXCLUSION MAY NOT APPLY TO YOU.

MISCELLANEOUS. If the copy of the Software you received was accompanied by a printed or other form of "hard copy" End User License
Agreement whose terms vary from this Agreement, then the hard copy End User License Agreement governs your use of the Software. This
Agreement represents the complete agreement concerning this license and may be amended only by a writing executed by both parties. THE
ACCEPTANCE OF ANY PURCHASE ORDER PLACED BY YOU IS EXPRESSLY MADE CONDITIONAL ON YOUR ASSENT TO THE TERMS
SET FORTH HEREIN, AND NOT THOSE IN YOUR PURCHASE ORDER. If any provision of this Agreement is held to be unenforceable, such
provision shall be reformed only to the extent necessary to make it enforceable. This Agreement shall be governed by Texas law (except for conflict
of law provisions). The application of the United Nations Convention of Contracts for the International Sale of Goods is expressly excluded.

U.S. GOVERNMENT RESTRICTED RIGHTS. Use, duplication or disclosure by the Government is subject to restrictions set forth in subparagraphs
(a) through (d) of the Commercial Computer-Restricted Rights clause at FAR 52.227-19 when applicable, or in subparagraph (c)(1)(ii) of the Rights
in Technical Data and Computer Software clause at DFARS 252.227-7013, or at 252.211-7015, and in similar clauses in the NASA FAR
Supplement. Contractor/manufacturer is Blue Squirrel, 686 E. 8400 South Sandy, UT 84070.
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